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Qualtrics Basics 

Creating a New Qualtrics Account 
Note: Anyone with a Purdue career account can 

create a Qualtrics account. 

1. In a Web browser, navigate to 

purdue.qualtrics.com.  

2. Enter your Purdue Career Account 

username and password and click Login 

3. In the page that opens under “This seems to 

be the first time you are logging in to 

Qualtrics,” select I don’t have a Qualtrics 

account 

4. In the page that opens, select I agree to 

accept the Terms of Service 

Creating a Project 
Note: Project is the new term for surveys 

created in Qualtrics 

1. On the Projects page, click Create Project 

a. Note: If you wish to place the 

Project in a specific folder, select 

the folder before clicking Create 

Project 

2. In the window that pops up, select either 

Blank Survey Project on the Research Core 

tab and enter a Project Name or… 

3. Select Create From Existing to create a 

project From a Copy, From a Library, or 

From a File 

a. Note: The file type to create from a 

file is an exported .qsf file, which 

stands for Qualtrics Survey Format 

4. Click Create Project  

My Tasks 
Note: My Tasks is a new feature in Qualtrics 

that helps you keep track of the steps in 

collecting survey responses with Qualtrics. Click 

on the different tasks in order to find links to 

the help page for the task.  

Note: If you close out of the My Tasks list, click 

on this icon at the right of the page in order to 

open it again:  

Creating & Arranging Questions 
Note: Any changes you make to a survey are 

automatically saved and can be tracked by the 

blue flashes of text in the upper left of the 

screen as pictured below. 

 

Creating/Adding Questions 
1. Open the project 

2. Click Create a New Item.  

a. The default question type is 

Multiple Choice. 

3. If desired, under Change Item Type on the 

right, click the drop-down menu and click 

the desired type to change the question 

type. 

 

4. Write the question text in the proper field 

5. If needed, type the choices for the question 

in the proper fields. 

6. If desired, click the – or + buttons under 

Choices on the right panel to add or delete 

choices. 

 

a. Note: Checking the box for 

Automatic Choices brings up 

options for choices that best match 

the question type such as a five 

point Likert scale for a matrix table 

question. 

Moving Questions 
1. Open the desired project 

2. Place the cursor over the desired question 

https://www.purdue.edu/apps/account/cas/login?service=https%3A%2F%2Fwww.purdue.edu%2Fapps%2Fidphs%2FAuthn%2FRemoteUser
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a. An icon with arrows will appear on 

the left. 

 
3. Click the down arrow to move a question 

down 

a. Or click the up arrow to move a 

question up 

Deleting Questions 
1. Open the desired project 

2. Place the cursor over a question 

a. The Remove Question icon appears 

on the right 

 
3. Click the Remove Question icon 

Editing Questions 

Rich Content Editor 
1. Open the desired project 

2. Click the desired question text 

3. Click the Rich Content Editor tab 

 

a. A text editor window will pop up 

4. Format or edit the desired text 

5. Click anywhere outside the formatting box 

to exit the Rich Content Editor 

6. To use the Rich Content Editor for choice 

text, click the choice text 

7. Click the dropdown arrow to the right and 

select Rich Content Editor 

 
8. Format or edit the desired text 

9. Click anywhere outside the formatting box 

to exit the Rich Content Editor 

Force Response 
Note: When this option is selected, it requires a 

compulsory answer to the question from the 

user. 

1. Open the desired project 

2. Click the desired question 

a. Question tools will appear on the 

right 

3. Under Validation Option, check Force 

Response. 

 

Randomization Options 
1. Open the desired project to edit 

2. Click the desired question 

3. Click the Block Options dropdown menu 

and select Question Randomization 

 
4. Click the desired randomization option 

a. Click Advanced Randomization for 

advanced options 

5. Click Save 

Editing a Project 

Look & Feel 
1. Open the desired project to edit 

2. Under the Survey tab, click Look & Feel  

a. The Look & Feel window will open 

3. Click the Survey Themes button 

 
4. Click the desired template 

a. A preview will be displayed 
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5. If desired, you may also change fonts, 

colors, or edit the header & footer 

6. Click Save 

Survey Options 
1. Open the desired project to edit 

2. Under the Survey tab, click Survey Options 

a. The Survey Options window will 

open 

3. Check the desired boxes related to the 

actions 

4. Click Save when finished 

Locked Survey 
Note: When a survey has collected responses, 

the survey will lock in order to prevent 

invalidation of the collected responses. To 

unlock the survey to edit questions: 

1. Open the desired project to edit 

2. Click Unlock near the top of the screen: 

 

3. Alternatively, if you open a survey with 

collected responses and begin editing, 

the “Unlock your active survey?” 

window will pop up. 

a. Click Unlock to unlock your 

survey. 

Preview Survey 
1. Open the desired project 

2. Click Preview Survey under the Survey tab 

a. This will preview the survey both in 

a browser view and a mobile view 

3. To exit the preview, click Close Preview 

Distributing a Survey 

Creating a Link to Your Survey 
1. Open the desired project and click the 

Distributions tab 

a. Select Get a single reusable link 

under Email to generate an 

anonymous link that can be copied 

and pasted anywhere 

2. Click the desired form of distribution 

a. Select Use Anonymous Link under 

Web generate the same type of link 

as above under Email 

b. Select Social Media to generate a 

post on social networks such as 

Facebook with a link to the survey 

c. Select Mobile to generate a QR 

code that can be used on mobile 

devices 

Email Survey 
1. Open the desired project and click the 

Distributions tab 

2. Click Emails on the left panel 

3. Click Compose Email 

4. In the To: field, click Select Contacts to 

generate a new contact list or to select an 

existing one. 

5. In the When: field, specify when the mailing 

will be sent out 

a. Note: It is automatically set to Send 

in 1 hour, but can be changed to be 

sent immediately 

6. Fill in the Subject field 

7. If necessary, click Save 

8. Set up the Message: field as a regular email 

message 

9. If desired, click Send Preview Email to see 

what it will look like for recipients 

10. Click Send 

Post a Survey on Your Website 
Note: This generates the HTML for a hyperlink 

to post on your website. 

1. Open the desired project and click the 

Distributions tab 

2. Click the Anonymous Link tab to the left of 

the page 

3. Click Customize Link 

4. Enter the text for the hyperlink in the Link 

Text box 

a. The code will appear in the HTML 

box with a preview below it 

5. Copy and paste the HTML code into the 

webpage’s code 

Contacts 

Creating a Contact List 
1. Click the Contacts tab > Create New 

Contact List. 

2. Enter the list name in the Name field. 

3. Select a folder, if desired. 

4. Click Next. 
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5. Click the desired method of adding 

contacts.  

a. Import From a File – upload a 

spreadsheet of members. 

b. Add Manually – fill in a form. 

c. Import From a Survey – use previous 

survey responses to build your panel. 

6. Click Add Contacts 

Editing a Survey Flow 
1. Open the desired survey to edit. 

2. Click the Survey Flow icon in the grey 

navigation bar. 

 
3. To add a new element, click Add a New 

Element Here. 

4. Click the desired element, e.g., End of 

Survey. 

5. If desired, click Move and drag it to the 

desired location. 

a. Or, by clicking the element and pressing 

the Up or Down arrow key on the 

keyboard. 

6. Note: If desired, to add element(s) between 

blocks, click Add below with a block. 

7. Click Save Flow when finished. 

Setting Branch Logic 
1. Open the desired survey. 

2. Click Survey Flow. 

3. Click Add Below or Add a New Element 

Here > Branch. 

4. In the branch, click Add a Condition. 

5. Click the drop-down menus to set the 

conditions. 

6. If desired, click the plus button  on the 

right of the current condition to add 

multiple conditions. 

7. Click OK to save the condition(s). 

8. If desired, click Move and drag the element 

under the branch that will be displayed if 

the condition is met. 

9. If desired, click and hold the Move button 

of an element, drag it to the Add a New 

Element Here link under the branch. 

10. Click Save Flow when finished. 

Trigger 

Setting up an E-mail Trigger 
1. On the survey toolbar, click the Tools drop-

down menu.  

2. Move the cursor over Triggers, click Email 

Triggers… 

3. Note: By default, the e-mail trigger will be 

sent whenever a participant completes the 

survey. 

a. If desired, click Add a Condition to set 

the trigger to send when the survey is 

completed and a condition is met. 

4. Fill in the to e-mail address in the To Email 

Address field. 

a. Separate email addresses with commas 

b. Piped text can also be used to bring in 

information from the survey 

5. Enter a subject in the Subject field.  

6. Compose a message in the Message field. 

7. If desired, click When, when the triggered 

message should be sent.  

a. By default, it will be send immediately 

after a respondent finishes the survey. 

8. If desired, un-check Include a Response 

Report.  

a. By default, a response report showing 

all of the participant’s answers will be 

sent. 

9. Click Finish Editing > Save Triggers. 

Quota 

Creating a Quota 
1. On the survey toolbar, click the Tools drop-

down menu. 

2. Click Quotas… > Add a Quota 

3. Select Simple Logic Quota for a standalone 

logic sets or Cross Logic Quota for cross-

referencing logic sets 

4. Enter a name in the field. 
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5. If desired, change the number (Quota limit) 

to the left of the Quota name. 

 
6. Create a condition that needs to be met for 

the quota to be incremented. 

a. Click the plus button  to the right of 

the condition to add multiple 

conditions. 

7. Click the dropdown newt to, "When the 

quota has been met, then:" to add an 

action once the quota has been met. 

a. End the Current Survey – If a 

participant fits in the quota, they will 

immediately be directed out of the 

survey. 

b. Prevent All New Survey Sessions - No 

new participants will be able to enter 

the survey once the quota is met 

c. Do Not Display a Question – Choose a 

question to be hidden once the quota 

has been met. 

d. Do Not Display a Block – Choose a 

block to be hidden once the quota has 

been met. 

e. Trigger Web Service – Opens 

information from a webpage 

f. None – Use the Display Logic or the 

Survey Flow in your survey to specify 

what happens when the quota is met. 

8. If Do Not Display a Question or Do Not 

Display a Block is selected, check Only do 

this if the current respondent meets the 

quota condition. 

9. Click Save when finished. 

Changing the Current Quota Count 
1. Click the Tools drop-down menu > Quota… 

2. Click the desired quota. 

3. If the current count is 0, click Set Count. 

4. Enter the desired number and click OK. 

5. If the current count is not 0, click Reset to 

set it back to 0. 

Scoring 
1. On the survey toolbar, click the Tools drop-

down menu > Scoring… 

2. To give any choice a point value of 1, click 

the desired choice once. 

a. The value of 1 will appear to the left of 

the choice. 

3. To give a choice a point value other than 1, 

highlight the current point value and type 

the desired value. 

4. To automatically score choices, click Auto in 

the desired question block.  

5. For a Matrix Table, click the desired row 

statement once. 

6. For a Text Entry question, type in the 

desired text in the Enter Text Response For 

Grading field. 

 
a. Point value of 1 will be automatically 

assigned after entering the response.  

i. To change the point value, click the 

current point value and type the 

desired point value. 

b. To add multiple responses, click the 

plus button  . 

7. To clear scores, click Clear in the desired 

question block. 

Displaying the Score for Your 
Participants 

1. On the survey toolbar, click the Tools drop-

down menu > Scoring… 

2. Click the Category drop-down menu > 

Manage Categories… 

 
3. On the Manage Scoring Categories pop-up 

window, check At the End of the Survey or 

After Each Question. 

4. Click Save. 

Viewing Results 

Reports 
1. Open the desired project and click the 

Reports tab 

a. The Initial Report will be opened 

automatically. To generate a new 

report, click the Report dropdown 

and select Create New Report. 
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2. To create a visualization via a graph or 

chart, click Add Visualization at the bottom 

of the page. 

3. Use the right panel to change the type of 

visualization. 

 

Generating a Report to Word, 
PowerPoint, Excel, or PDF 

1. Open the desired project and click the 

Reports tab 

2. On the top right side of the page, click the 

Report Options dropdown 

3. Select Export Report then the desired 

format 

 

Filtering a Report by Date 
1. Open the desired project and click the 

Reports tab 

2. Click the Add Filter dropdown 

3. Under Survey Metadata, select Start Date 

 
4. Click the Select Operator and choose from 

the available options 

a. Choosing Between will give you the 

option of a date range. 

Create a Printed Report (Previous 
Format) 

1. Open the desired project and click the 

Reports tab 

2. Click Printed Reports 

3. Click Create New Report 

4. If desired, type a title in the Report Name 

box 

5. In the Generate Report box, select the Page 

Size, Layout, and questions by clicking the 

checkbox next to them 

6. Click Generate Report 

7. To save, click the Share dropdown and 

select the desired format 

Adding New Survey Data 
Note: Added survey data will be appended to 

the current report. 

1. Open the desired survey then select the 

Reports tab 

2. Click Printed Reports then Create New 

Report 

a. If you are adding survey data to an 

existing report, click on the desired 

report. Skip to Step 8. 

3. If desired, change the page size and theme 

in the Page Size and Theme categories 

4. Under Select Layout, click the desired 

layout 

5. Under Select Questions, check or un-check 

the desired question(s) to be displayed in 

the report. 

6. If scoring is desired, under Select Scoring 

Categories, check or un-check Score 

7. Click Generate Report 

8. Click the Report Options drop-down menu. 

9. Place the cursor over Data Source Options 

and click Add a New Data Source… 

10. Click the Choose a Survey… drop-down 

menu and select the desired survey. 

 
11. Click the Data Source options dropdown 

icon  

12. Click Generate Report. 

13. Select either Create a new page for each 

question (recommended) or Merge this 

data source with the existing report. 

14. Click Generate Report when finished 

Removing Data Source 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report 

2. Click the Report Options drop-down menu. 
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3. Place the cursor over Data Source Options 

and click Remove Data Source. 

a. If a report contains multiple data 

sources: Place the cursor over Data 

Source Options, move the cursor to the 

desired survey’s name. 

b. Click Remove Data Source. 

4. If desired, un-check the option(s). 

5. Click Remove Data Source. 

Changing Table Type 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report 

2. Click the desired table. 

a. Table toolbar appears.  

 
3. Click the Table Type drop-down menu and 

select the desired type. 

Changing Table Options 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report 

2. Click the desired table. 

3. Click the Table Options drop-down menu. 

4. To change table appearance, click one of 

the four images under Fonts. 

 
5. To Sort the data in the table, place the 

cursor over Sort By and select the desired 

option. 

6. To show/hide columns, place the cursor 

over Show/Hide Columns and check or un-

check the desired column(s). 

7. To show/hide rows, place the cursor over 

Show/Hide Rows and check or un-check 

the desired row(s). 

8. To change the data format, place the cursor 

over Data Format and select the desired 

format. 

9. To export table, place the cursor over 

Export Table To and select the desired 

download format. 

a. Save or download the file. 

Changing Table Layout 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report 

2. Click the desired table. 

3. Click the Layout drop-down menu and 

select the desired layout option. 

Adding New Page 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report 

2. At the bottom left corner, click New Page. 

a. The new page will be appended to the 

last page. 

Removing a Page 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report 

2. On the top right corner of a page, click the 

page name > Page Options drop-down 

menu > Remove Page. 

 

Reordering Page 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report 

2. On the left side, click the desired page. 

3. Drag the page up or down to the desired 

location. 

Adding New Table/Graph 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report 

2. On the desired page, click New Table or 

New Graph icon from the toolbar. 

3. On the page, click the desired table or 

graph. 

4. If desired, change the data source. 

a. From the report toolbar, click the Data 

Source drop-down menu > Select Data 

Source... drop down menu. 

b. All data sources will be included in the 

new graph or table. Click the drop-

down menu listing the data source to 

change the data source or click the 

 icons to remove or add a data 

source 
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Export Report 

Qualtrics Format (qrf) 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report. 

2. Click the Report Options drop-down menu 

> Save To File… 

3. Save or download the file. 

Other Formats (PDF, xls, docx, or pptx) 
1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report. 

2. On the right side, click the Share drop-down 

menu. 

  
3. Click the desired report format based on 

the corresponding icon. 

4. Save or download the file. 

Importing a Report 
Note: Imported report will replace the current 

report. 

Note: Qualtrics only supports Qualtrics 

formatted report type (qrf). 

1. Open the desired survey then select the 

Reports tab, Printed Reports, and the 

desired report. 

2. Click the Reports Options drop-down menu 

> Import Report…  

3. Click Browse… to locate and open the 

desired report. 

a. Click Choose File if using Google 

Chrome. 

4. Click Import. 

Searching Recorded Responses 
1. Open the desired project and click the Data 

& Analysis tab 

2. Under the Data tab, select Add Filter 

a. Search responses between dates, 

by type, specific panel members, 

name, e-mail, or external data 

reference. 

Export Data 
1. Open the desired project and click the Data 

& Analysis tab 

2. Click Export/Import 

3. Click Export Data 

4. Click Export Complete Data Set 

5. Select the file type among the tabs listed for 

CSV, XML, SPSS, and other types of files 

6. Click More Options to change the options 

for the downloaded data 

7. Click Download 

a. Files are automatically set to be 

compressed as a .zip file. Uncheck 

the “Compress data as .zip file” box 

under More Options to download 

an uncompressed file. 

Export 

Exporting Survey 
Note: A Qualtrics format (.qsf) file will be 

downloaded. 

1. Open the desired project and click the Tools 

drop-down menu > Export Survey. 

2. Save or download the file. 

Exporting Survey to Word 
Note: A Microsoft Word format (.docx) file will 

be downloaded. 

1. Open the desired project and click the Tools 

drop-down menu > Export Survey to 

Word… 

2. If desired, check or un-check the following 

options. 

 
3. Click Export. 

4. Save or download the file. 
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Import Survey 
Note: Only .qsf (Qualtrics Survey Format) files 

can be imported 

1. On the My Projects page, click Create 

Project 

2. On the left, select From a File 

3. Click Choose a .QSF File and navigate to the 

desired survey 

4. Click Open. 

5. Enter a Project Name and if desired, select 

a folder 

6. Click Create Project when finished 

Closing a Survey 
1. On the My Projects page, click the Actions 

button to the right of the desired survey 

2. Click Close from the dropdown 

3. In the window that pops up, select whether 

to Close all active survey sessions and 

record them as partial data or Allow all 

active survey sessions to be finished 

4. Click Pause Response Collection 

Deleting a Project 
Note: This will permanently remove both the 

survey and all responses. 

1. On the My Projects page, click the Actions 

button to the right of the desired survey 

2. Click Delete Project from the dropdown 

3. In the window that opens, check the 

textbox next to "All data related to this project 

will be permanently deleted." 

4. Click Delete Project 


